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Preface

Design is a slippery subject. Much of good design is a matter of taste, and tastes, like fashions, change.
But leaving out the question of fashion in design, some tastes are better than others.

You would expect someone who has studied design and has created what others consider good design to
have better taste in design than the ordinary person. But some ordinary people have better design taste than
others.

How do they achieve this better design sense? By observation, simple observation. We are surrounded
by examples of good design; all we have to do is take the time to look closely at what we take for granted.

Many commercial artists maintain files of designs that they like; you can do something similar. Take a
few minutes to thumb through magazines. Cut out examples of logos that appeal to you and study them
before you begin to create your own logo. For example do Black & Decker and Calvin Klein use such a
simple typeface in their logos? Why do Coca-Cola and Del Monte use more ornate designs?

There are no firm answers to either of those questions. In general, sans serif typefaces have a more
contemporary feel, while the look that Coca-Cola and Del Monte are striving for is traditional.

Once you begin to get a feel for what appeals to you and figure out why you like it, you will find that creating
a logo of your own is much easier than you ever thought possible.

Important Notice: The corporate logos included in this User’s Guide are trademarks of the respective

companies. They are provided only as examples, and you should contact the companies regarding the use

of their marks in any cooperative advertising or joint promotional activities. The sample logos provided in

electronic format are subject to the same guidelines. They are provided so that you can display them on

screen to view the logos in color and to test the principles discussed in the User’s Guide relative to the

appearance of the logos at various sizes. The inclusion of these logos does not grant you any rights to use

them except in accordance with the guidelines available from the respective companies.
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Chapter 1: Design Considerations

Arts & Letters EXPRESS is one of several vector graphics programs with all the tools you need to
create a logo perfectly suited to you and your business.   As we impled in the introduction, logo is a general
term. In our discussion of design, we will use the more specific terms signature, mark, and wordmark.

Many of the examples we utilize to illustrate definitions or good design principles are those of established
companies. These logos are registered and are the property of the companies and products repre-
sented. They are included in the logo collection to be used as examples of successful logo design or for
use when personalizing proposals and communications with any of the companies. Study these familiar
logos as you formulate your own design ideas. While you shouldn’t imitate them, you should imitate the
principles behind their design.

Signature
A signature is the name of a company or an individual set in a distinctive style of type. “Distinctive,”
however, does not mean trendy or faddish. Imagine how dated a business would look today if it had
chosen in the late-sixties to use psychedelic lettering in its signature:

Not only does the sixties-era typeface look dated, it never really had anything to do with the company it
was supposed to represent. Tools are angular and hard; the typeface is soft and fluid. A good signature
suggests something about the company.

Sometimes the designer of a company signature achieves a distinctive look by beginning with an
appropriate typeface, then personalizing it. It doesn’t matter if another designer chooses to use that
typeface; the personal touch makes the company’s signature different.

Arthur Andersen & Company, starts with a face perfect for a financial company — one that is classic and
conservative. A distinctive touch is achieved with the “swash” extension of the ampersand, a feature not
to be found in the original typeface.
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Quaker makes a similar change by extending the tail of its “Q.” In addition, the basic typeface is quite
distinctive, tieing together nicely with the pleasantly chubby Quaker gentleman that is its mark.
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Nestle uses two personalizing touches: a swash extension to what would be the serif of its capital N and
a variation of the accent mark on the final e. The accent mark echoes and continues the swash extension
of the N.

Using swash letters is not the only way to personalize a typeface; you can also “freeform” and edit
key letters. Note how RCA alters the R and the A to make them appear to mirror each other.

Mark
A mark is a graphic design used to represent a company. Marks generally suggest something about
their makers, but the connection is not always readily apparent. For example, the connection
between Shell Oil and its mark is obvious to any consumer, but the meaning of Ralston Purina’s
checkerboard design is less clear. (It is, however, a measure of the power of association and the
strength of a good mark that the checkerboard design says “Purina” to most consumers.)

No matter how closely linked a mark is to its maker, it is always simple and graphically strong.

Examples of well-designed, graphically strong marks include those of Ralston Purina, Shell Oil,
United Way, Quaker, Motorola, and Brunswick.
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One way in which a company can gain for its mark the kind of identification that Ralston Purina has
with its checkerboard is to link its mark with its signature. If the public sees the two together often
enough, eventually the signature can be dropped and the mark will stand on its own.

A company’s signature and mark are often used together, with detailed corporate rules for their
display, but each can stand alone to symbolize the company. Examples of the signature-mark
combination include those of Brunswick, Motorola, Nestle, and Quaker.

Wordmark
A “wordmark” is a graphic design that incorporates the name of the company into the design. When
a mark-and-signature combination is broken apart into a mark and a signature, both still clearly
represent the company, but when a wordmark is broken apart, one of the pieces loses its identification
with the company.

Examples of the wordmark are Oscar Mayer, Phillips 66, NCR, and Sun. In each case, if the company
name or its initials (NCR) are separated from their graphic, the effect is completely different and less
effective. The Phillips 66 wordmark, for example, becomes “Phillips 66” and a shield shape — losing
the clever play on the route 66 highway sign.
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Checklist for a Good Mark
There are several characteristics of a good mark that you should consider in judging your own mark.
A good mark design should be:

1. Original and distinctive. Many companies use the shape of the state of Texas as the basis of their
marks. Some of the ways in which they have made their design distinctive are by employing heavy
lines on the outline, using a solid interior, and placing their initials within the state (making it a
wordmark).

2. Legible. A good test of the legibility of a design is to print it at the size it will be used, tape the design
to a wall, and take a few steps back. Can you still tell what it is? What happens to your mark as
you enlarge or reduce it? The thin lines in a mark designed for stationery may look weak if the mark
is enlarged to fit on the side of a truck, and vice versa. Keep in mind the possible uses for your mark.

3. Simple. Unless you are trying for a somewhat old-fashioned feel, make your mark as simple and
abstract as possible. Ralston Purina’s checkerboard and Quaker’s “Friend” are two examples of
simple, memorable marks. But Nestle’s bird nest, while old-fashioned in the complexity of its
illustration, projects perfectly the organization’s tradition and stability.

4. Memorable. A memorable mark is one that is striking and easy to remember. Simplicity is the key;
think of Shell Oil Company’s yellow scallop shell.

5. Easily associated with the company. It is harder for a consumer to associate a heart shape than a tool
shape with a hardware store. This is not to say that you can’t use a mark that seemingly has no
connection with the business; after all, the stag that represents John Deere has nothing to do with
tractors and everything to do with the company’s name.

In addition, a good mark should:

6. Make wise use of color. Printing in a color other than black increases the cost of printing, and the
more colors involved, the greater the expense. One way to economize is to use screens or
percentages of a single color instead of multiple colors. Products such as EXPRESS allow you to
convert a logo design with multiple colors into shades of gray automatically. You can lighten or
darken individual elements to balance the contrast and preview the design as it will appear when
printed in a single color. The preview is an important step, because certain colors change
dramatically when screened as a percentage of the base color. For example, red becomes pink,
which may be unacceptable.

7. Project the image of the company. The mark of an accounting firm should be more conservative than
that of a graphic design company. An avant-garde mark will not project the stability that an
accounting firm wants; a staid mark may not project the innovative feel that a graphic design
company needs.

After you have considered the design principles utilized by established companies and read the
checklist for a good mark, you can proceed with the design of your own.



Chapter 2: Creating a Logo

Arts & Letters EXPRESS gives you the tools you need to create a successful logo design: hundredsof
basic designs, patterns, icons and design examples (shown in Appendix A), over 250 corporate logos
in full color (see Logos in the Clip-Art Manager), and this guide.

We’ll look first at designing a logo using a clip-art symbol; then we’ll show you how to use the graphic
elements and designs included with EXPRESS to create a logo. (You can, of course, combine any clip
art with the graphic elements and designs.)

Creating a Logo Using Clip Art
Let’s design a logo for Mercury Couriers. Mercury Couriers is a business delivery service, and the
name was chosen by the owner to suggest speed and dependability. (Mercury was the Roman
messenger-god, often depicted as wearing winged sandals and winged helmet.)

The first image that occurs is that of Mercury running. One reason that this image might come to mind
is that it is a well-known mark, that of FTD Florists. Although a business delivery service and florists
are two different businesses, the owner of the image of Mercury running might not be pleased to see
its image being used by another business.

But the suggestion of swiftness that Mercury carries, so desirable to a delivery service, is too good to
let go. What about a side view of Mercury’s head, with his winged helmet for identification? Again,
that image has been used by a large firm, Ford Motor Company, as the mark for its Mercury
automobiles. Although Ford hasn’t actively used this mark for many years, it is probably easier to
continue thinking than to chance trademark infringement.

What about a top view of the helmet? Add symbol number 21233 to see how it looks:

It’s an interesting graphic as it is, but it doesn’t look much like a helmet — until we size it non-
proportionally, by clicking and dragging on the bottom middle point handle.

Suddenly, we have what could be a top view of Mercury’s helmet.
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In addition to being a top view, it looks different from both of the other well-known trademarks: more
ornate, larger wings. The empty area in the center of the helmet looks like a good place to put the
company’s name, “Mercury Couriers,” and thus create a wordmark.

Just putting the words into the open space might work, but the words seem rather small. In addition,
they are arranged in a strictly linear fashion (horizontal), whereas the rest of the mark is nonlinear
— all curves. With a little work, we could make the arrangement of the company name echo the
curves of the mark.

Using EXPRESS’ advanced tools, we can curve the text to fit within the confines of the helmet’s circle.
Here’s how:

1. Add a circle symbol from the Shapes flyout and size it to fit within the helmet’s circle.

2. With the circle still selected, choose Convert to Freeform from the Draw menu. The circle is no
longer a symbol but a freeform object, which means that it can be broken apart.

3. With the circle still selected, choose Freeform/Text Edit from the Draw menu. Notice that the
interior color disappears, leaving just the outline of the circle with four points showing.
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4. Select the Split tool from the Toolbox. The cursor changes to the Split tool. Split the circle at its left
and right points. Now you have two arcs that fit perfectly within the empty circle in Mercury’s
helmet.

5. Now type the word “Mercury.” Choose Modern Medium from the Custom Type dialog box and
“Centered” alignment. Open the Spacing dialog box and choose greater values for letterspacing,
to space the letters out. Repeat the process for “Couriers.”

6. Block select “Mercury” and the upper arc.

7.  Pull down the Effects menu and choose Bind to Shape. In the Bind-to-Shape dialog box, choose
“Top” for placement and deselect
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“Show Shape.” Click on OK, and EXPRESS binds “Mercury” to the upper arc.

8. Repeat the process for “Couriers” and the bottom arc, this time choosing “Baseline” for
orientation. Click on OK.

“Couriers” is upside-down.

The reason it is upside-down has to do with the direction in which the bottom arc is being drawn.
When both arcs were one circle, that circle was being drawn from the point farthest to the left (that
we used to guide the Split tool) clockwise. When the circle was split into two arcs, each arc continued
to draw clockwise, which is why “Couriers” is upside-down. If you look at the orientation of both
words, it makes sense. But it doesn’t make a very good wordmark. Fortunately, it can be fixed.

9. Ungroup “Couriers” and its arc; select the arc. Pull down the Draw menu and select “Reverse
Points Order.” Choosing this option with the arc selected will cause the arc to draw counter-
clockwise.

10.Bind “Couriers” to the arc again. Now the word is oriented correctly, and we have an improved
wordmark for Mercury Couriers.
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Using the Designs, Patterns and Icons

See Logo Designs, Patterns and Icons in the Clip-Art Manager or print a copy of these libraries using
the Clip-Art Viewer. Many of the patterns consist of repeating elements, which can be broken apart
if you wish to use just one of the repeated shapes.

Hundreds of other design elements are included with Arts & Letters EXPRESS; you will find them in
the Clip-Art Manager under the “Design” categories.

Some of the patterns may appear too dense when used at a small size. There are two ways to control
this density: One is to turn the element white and place it on a solid background; the other is to stretch
the shape non-proportionally:

The icons in the Logo Icons library can be used to make simple, forceful logos or graphics quickly. For
example, combining the icon of a house (symbol  25225) with a suitable typeface produces a nice
notice for an open house:

The icon of a leaf (symbol 26207) could be used to create a logo for a nursery, and symbol 26198
(duplicated, flipped, and enclosed in a rectangle with rounded corners) could become a logo for a cat
breeder:
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Using EXPRESS’ design elements is easy. The only difficult part is deciding which effect out of all the
choices is correct for your logo.

Let’s create a logo for an enterprising company named “Global.” An design obvious solution would
be to pair the company’s name with a globe of some sort.

The result isn’t very exciting. What happens if we create a wordmark by making “Global” all-caps
and replacing the letter “o” with the globe?

The design looks better, but the globe itself is wrong. It’s too detailed; when this wordmark is reduced
to the size necessary for reproducing on stationery or business cards, the continents will lose their
detail and fill in with ink. In addition the typeface, which is Classic Medium, looks rather weak to
carry such a powerful name as “Global.”

This is where having over ninety typefaces and a wide variety of design elements are useful. While
EXPRESS does provide icon representations of a globe that could be used instead of the realistic clip-
art globe, we’ll go further and create a completely abstract globe.

First, we add the pattern shown below (symbol 21169), then place a simple circle on top of it. Select
both the circle and the design element and choose Merge from the Effects menu. Choose Clipping

Path and specify “no outline” by clicking the appropriate box. Click on OK.

The design element is clipped in the shape of a circle and becomes an abstract representation of a
globe.
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Because diagonals are more dynamic than horizontals, we’ll rotate the globe slightly, and before
substituting it for the “o,” we’ll choose a more imposing typeface, Modern Heavy.

There are two ways you can make such a substitution for a letter. You can either freeform the text and
delete a letter, or you can actually have two text objects, “GL” and “BAL,” aligned with each other,

and maneuver the globe into place by hand. The resulting wordmark is modern-looking, and if Global
were a computer chip manufacturer, the logo would be perfect. (Note how the lines in element 21169

suggest the pins that secure chips to boards.)

Using a clipping mask on EXPRESS’ Logo Patterns is a useful tool. You can make a simple teardrop
shape (symbol 2598) into something more, simply by choosing the right pattern (in this case, symbol

21219).

Place the teardrop over the element and clip it. (If you think that the clipped shape is too indefinite,

you can specify that the outline show.) Add type and you have an attractive logo.

Another use for the clipping mask is to achieve a “two-tone” effect with text, as shown below:
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Another use for the clipping mask is to achieve a “two-tone” effect with text, as shown below:

First, add your text.

Next, duplicate the text object and align the copy with the original. You can do this two ways. You
can use the Transform dialog box to specify “Make Duplicate,” and this will create a copy directly
on top of the original (no other alignment necessary). You can also simply make a duplicate using the
Duplicate tool, then block select the two text objects and align them using the Arrange menu.

Place a rectangle over half of the text, and with the rectangle still selected, select one copy of the text
by using Shift + Click.

Now you have a text object and a rectangle selected. Pull down the Effects menu and select Merge.
Choose Clipping Path and specify “no outline” by clicking the appropriate box. Click on OK.

The text is clipped and appears as above.



Arts & Letters Logo Design 16

Note that you will actually have two objects that need to be grouped, so that they aren’t accidentally
misaligned: a text object and a mask group. Before you group them, however, you can select and color
either object to make the contrast in color as striking as you want. You could stop at this point and
have an interesting text effect, but we’ll finish the effect by adding the contrasting rectangles.

Add a rectangle the color of the bottom half of the text.

Send the rectangle to the back.

Repeat the process for the second rectangle and maneuver the two into alignment with each other.

For more design examples, see Appendix A.
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Chapter 3: Designing a Letterhead

There are two basic elements of a letterhead: your logo and your identification (which includes name,
address, and telephone number).

Some letterheads include such information as company officers at the bottom of the paper. Your logo
is included in the letterhead because you want it to be identified with you; your address and phone
number are included for obvious reasons.

Since you have already designed your logo, creating business stationery will be relatively easy. When
you created your logo, you designed it to project an image, and stationery is an important component
of projecting that image. Every time you correspond with someone, your stationery must carry the
image successfully, present you as favorably as possible. What you write is important, of course, but
how it looks is almost as important. How impressed would you be to receive a bid for your business
that was typed on blue-lined, hole-punched notebook paper?

Paper
Business stationery is available in various colors and textures, and most have matching envelopes and
card stock. Before you make your choice, you should consider the following:

• The most common, conservative, color for business stationery is white. But white is a good choice
for reasons other than the safety of conformity: colored inks (if you wish to use them in your mark
and signature) look their best on it, and the contrast between the black letters in your typing is the
most extreme and legible possible.

• Second to white is cream, and the same reasons for choosing it apply. Cream is a good choice for
someone who wishes to avoid the stark coolness of white, to add a little warmth to the appearance
of their communications.

• Light gray is third in popularity to white and cream. It avoids the starkness of white, without
adding the warmth of cream.

You may consider other colors, but keep in mind your image. Hot-pink stationery would not be
appropriate for an accounting firm, but for a party-supply store, it might be perfect. Before choosing
a colored stationery, however, remember the color of your logo. If your logo uses red ink and you
intend to print your stationery using colored ink, your red logo will appear washed out on hot-pink
paper. On the other hand, if you can change the color of your logo (for your stationery) to print with
blue or black ink, the hot-pink stationery would probably work.
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Athough stationery is available in many textures, if your mark and signature use complex, fine lines,
you should steer away from textured papers. Textured paper, because of the tiny hills and valleys that
make up its surface, does not allow fine detail to be reproduced. Smooth papers with a minimum of
texture will work better. If, on the other hand, your mark and signature use rather bold lines, you are
not so limited.

Choose a texture that is consistent with your image. There are textured papers which simulate
bamboo that might be appropriate for a business dealing with oriental imports; others with rigidly
geometric shapes might be appropriate for engineering firms.

Message Area
Since business communications are rarely handwritten, you must consider how your printer
(whether a typewriter, dot-matrix printer, or laser printer) will image your letter on your stationery.
This area can be can be referred to as the message area. The usual margins for a typewritten business
letter are one-inch to one-and-a-half inches left, right, top, and bottom. Of course, since your
letterhead will include information that is usually typed (name and address of sender), you do not
have to allow space for it.

In well-designed letterhead, the name, address, and mark appear in relation to the message area in
the letter, not to the piece of paper alone. In other words, if you customarily use margins of one-and-
a-half inches when you type correspondence, your letterhead will look more a part of the entire
message if it also begins and ends one-and-a-half inches from the left and right edges of the paper.
If it begins and ends one inch from the edges of the paper, the relationship between it and the message
will not be as close.

On the other hand, if your letterhead spans the entire width of the paper, it will appear to be
independent of the message typed below it, and the relationship spoken of above does not apply.

Type in the Letterhead
A common mistake seen in many letterheads is that the type is too large. If your letterhead intrudes
too much into the message area, not only will your letterhead appear overpowering, it will limit how
much you can type on your stationery. A good rule of thumb is to limit any type in your letterhead
to the range of 8 to 12 points.

Unless your logo is simply a mark (graphic design), you must be aware of the harmony between the
type used in your logo and that used in your letterhead. Harmony is a subjective thing; compare the
following variations of a signature-mark combination and letterhead.

1.

2.
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3.

None of the combinations are objectionable, but the first and last probably work best. Why? In
number 1, the typefaces are recognizably from the same family (Modern Heavy and Modern
Medium); they “go together.” In number 2, however, the letterhead type is close to that of the logo,
but not quite the same; it looks like a mistake, as if the creator meant to duplicate the logotype but
selected the wrong typeface. In number 3, the typefaces are intentionally different, which establishes
the logo as distinct from the letterhead type; a different effect, but just as harmonious.

Another related consideration is what typeface you will ordinarily use in writing letters. The rule of
number 3, above, is probably your best strategy here. If you normally use a serif face to type your
letters, a sans serif face in the letterhead may be better. This allows the necessary separation between
the body of the letter and the letterhead, which introduces it.

Another way to achieve the separation between body and letterhead is to italicize or slant the
letterhead.

Another, less satisfactory way to make the body copy and letterhead agree would be to use the same
typeface in each. This is less satisfactory because there will always be some variation between the two
in size or placement.
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As you design your letterhead, keep in mind your business cards. The two should resemble each other,
both using the same logo and type.

Envelopes
For consistency’s sake, the design elements you have created for your stationery should be used on
your envelope.

Sometimes, as in the “Sunnyside Company” example above, the logo and address combination will
be the wrong shape or size for an envelope. Using the Sunnyside Company letterhead design on an
envelope without altering its size or the placement of its elements would result in a top-heavy,
overlarge return address.

A quick solution would be to eliminate the mark and alter the company’s name to appear as the first
line of the address. The typeface will maintain a harmony between the letterhead and envelope.
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Another simple solution, which would allow the use of the signature-mark combination, would be
to place the address under it. The designer who opts for this solution might want to reduce the size
of the signature-mark somewhat to avoid the appearance of too much printing on the corner of the
envelope.
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Chapter 4: Designing a Business Card

Calling Cards
Calling cards were the precursors of business cards. They were the same size as today’s business
cards, but all that was engraved in the center of the card was the owner’s name. Not only was one’s
address not included, the name of one’s business was never included.

One’s calling card was presented at the door when one called upon a friend or acquaintance. A
servant would carry the card on a small silver tray to the person being visited, and that person would
decide whether to receive the guest.

Business Cards
Business cards are sometimes used like calling cards, but their object is usually commerce, rather than
conversation.

Businessmen and businesswomen exchange cards in offices, at social gatherings, at professional
meetings; they give them to secretaries and clients; they drop them in fishbowls at restaurants and
pin them to community bulletin boards. The hope is that perhaps out of this welter of tiny pieces of
card stock, some business will be generated. And that hope is realized often enough to make business
cards a business necessity.

Business cards are always approximately 2" x 3½". Anything larger and they will not fit in the
numerous devices for filing business cards (including wallets); anything smaller and they tend to get
lost. But the materials on which business cards can be printed are numerous and allow for a great
deal of originality!



Arts & Letters Logo Design 23

Checklist for a Good Business Card
Arts & Letters EXPRESS  gives you all the tools you need to create a business card that is perfectly suited
to you and your business. There are, however, several points you should consider before you begin.

1. If you are including your logo, make sure that it is large enough to hold detail but small enough not

to overwhelm everything else. With a field to work in of 2" x 3½", you must strike a balance between
the size necessary for your logo to be recognizeable and leaving sufficient room for the rest of the
information you wish to present.

Media & Message
In their quest to be different, to have their business cards stand out from all the rest, people have been
extremely inventive. Materials on which business cards have been printed include wood veneer (for
a lumber company), thin plastic, and metal (usually aluminum). Using such materials does make a
business card stand out. Unusual surface treatments have included photographs (sometimes of the
bearer, sometimes of a product or an office), 3-D images and holograms, and mirror-like Mylar
finishes. Sometimes the logo is embossed into ordinary card stock; sometimes the card is die cut in an
unusual pattern.

The message printed on business cards varies widely. Some businesses prefer to present their logo,
name, and address with the bearer’s name and phone number. Others add the company’s slogan, a
list of products, or a list of services that the business performs. Some add a joke or thought for the day
on the reverse side of the card.

The orientation of the message varies as well. Traditionally, the printed matter reads so that the card
is held horizontally, but many business prefer a vertical orientation.

Some skew their type and logo at an angle across the card.

Rather than strive for an unusually-designed card, some people use a very simple means of insuring
that their card will stand out in a stack of cards: they turn down one corner of the card before they
give it away.



Arts & Letters Logo Design 24

2. Be sure your type size is legible. Be sure that you keep the size of your type large enough to be readily
legible: point size 8 for a sans serif face; point size 9 for a serif face. Be wary, however, of rising above
point size 10 for any part of your message.

3. Avoid using too little letterspacing. Words with very little space between their letters look all right
at larger point sizes (10 and above), but when they are printed in small sizes, the individual letters
may touch and bleed into each other, blurring your message.

You can use the controls in the Custom Type dialog box to adjust the spacing between letters and
words.

4. Know that thermography is not good for detailed work. Thermography is raised (or relief) printing
done using plasticized ink that is heated so that it “puffs up.” It resembles the more costly process
of engraving and is often used on invitations and business cards to add a “touch of class.”

A limitation of thermography is that serif faces in small sizes tend to lose their serifs, and artwork
with fine lines tends to block up. In short, the amount of fine detail that thermography can
reproduce is much less than that of traditional printing (or true engraving).

If you keep these limitations in mind, you can work around them and use thermography.
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Phillips Designs

5. Match media to message. While a party supply shop could print business cards on bright plastic or
mylar, a lawyer should not. The most ordinary, conservative, safe medium for a business card is
the card stock that matches your business stationery. (Most types of stationery have envelopes and
business card stock that match.) White and ecru are the most common card stock colors, and black
and dark blue are the most common ink colors for business cards.

This not to say that you cannot have fun with your business cards, just that you consider how well
they match your business image.

6. Be wary of time-sensitive information. Because of the expense involved in printing business cards
(and letterhead), be careful what information you give. Which will last until you have used most
of your 500 minimum cards: your street address or a P.O. box number? Is there a chance that you
many drop one of the services you are putting on your card? (Sometimes it is easier to leave details
off than to spend time later marking through items that no longer apply.)

The sample cards shown below illustrate a few of the many ways a logo can be used as part of a
business card.
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Chapter 5: Designing a Product Label

Once you have designed your logo, letterhead, and business cards, it will not be difficult to design
a label for your product. After all, most labels incorporate the logo (or trademark) of their maker, and
you already have yours. The type that you use in your label could be the same as that in your signature
(or a variation of it). What will concern you mostly will be the positioning and relative size of these
elements.

The design of a part of your label may be out of your hands. For example, if you are required by the
government to incorporate certain information, such as a list of ingredients, you may find that the
list must conform to a standard design.

Allied Beverage Ice Mountain Soft Drinks
A Dallas-based soft drink company, Allied Beverage, used Arts & Letters to design both the logo for
its Ice Mountain soft drink line and the product label for its orange-flavored soda. Ralph Deal, a
partner in Allied Beverage, did the design work, but before he could begin, he had to first learn how
to use a computer. Ralph points to the ease of learning and using Arts & Letters, saying “If I can do
it, anyone can.”

Designing a Wordmark
For the Ice Mountain logo, Ralph chose to create a wordmark. First, to symbolize the eventual scope
of the Ice Mountain line, he used a globe symbol, one showing only latitude and longitude lines
(#4037). Rather than use the globe as it was, Ralph sized it nonproportionately and tilted (rotated)
it slightly.

In general, horizontal and vertical lines are static, while diagonal lines are dynamic. By rotating the
globe, Ralph gave it a certain amount of dynamism, a suggestion of movement.

Next, he created snow-capped mountains, using Arts & Letters drawing tools, and placed those
mountains on the North Pole of the globe.
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He then added the text “Ice Mountain,” selecting Classic Medium for the typeface and italics for the
style. Again, italicizing (or tilting) the letters gives the words a more dynamic feel. Using the Spacing
dialog box of the Text Attributes menu, he specified a Condense/Extend value of 50%, which made
“Ice Mountain” appear to be more narrow than normal.

Ralph wanted the initial caps (capitals) of the two words to be larger and more substantial than the
rest of the letters. To do so, he freeformed the text and altered the “I” and “M” to return them to their
original dimensions, then enlarged them. To give the letters a three-dimensional effect, he duplicated
the letters and used Arts & Letters drawing tools to connect them. (He might have found using Extrude
easier.)

After grouping all the letters, he tilted (rotated) them to the same angle as he had the globe, then fit
them to the center of the globe. The result comprised his wordmark logo.

Creating a Product Label
Ralph knew the dimensions of the soft drink can upon which the label would be printed, and he knew
how much of the can’s surface would be “live area,” the part of the can that the design would cover.
The live area, a rectangle measuring approximately 8" x 4", formed his canvas.

Part of his canvas was already accounted for: he had to list the ingredients in his soda, and he had
to give the liquid measure of the contents.

To continue the Ice Mountain theme of his logo, Ralph decided to create ice-capped mountains that
would run the length of the live area. Using Arts & Letters Bezier curve and line tools, he first created
the mountain peaks. Next, he created the ice caps, following the upper contours of the peaks, then
dropping into the bodies of the peaks to suggest crevasses. He added accents along the perimeter of
the ice caps.
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Knowing that the bottoms of the ice caps would be covered by other design elements, Ralph left them
as horizontal lines rather than waste time drawing something that would not show in the final
product.

He decided to color the mountains blue, and since the flavor of the soda was to be orange, he colored
the background orange.

Ralph decided that merely coloring the background of the can orange was not enough. To give
consumers a concrete suggestion of the can’s contents, he added an image of oranges from the Clip-
Art Manager.

 

Since he planned to reproduce the image of the oranges at a fairly large size, and since they would
be so integral to his design, Ralph freeformed the image and modified it, giving the face of the orange
greater detail. He added the word “orange,” again using Classic Medium and altering it to make it
similar in treatment to “Ice Mountain” in the wordmark. Knowing that his canvas would be
wrapped around a cylinder (the soft-drink can), he duplicated the word and placed both copies so
that “orange” could be seen from either side of the can.

After making a copy of the words “Ice Mountain” from the wordmark, he rotated it 90 degrees and
added it to the composition.

Several other blocks of text were included in the design: list of contents, the name and address of his
company, registration marks, and a public-spirited recycling message. The final label design
appeared this way:
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The soda cans themselves appeared this way:
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Chapter 6: Protecting Your Logo

Logos should be original and distinctive. You don’t want to accidentally design a logo similar to that
of another company, because you don’t want your businesses to be confused by the consumer. If,
however, the Westgate Oil Exploration Company and the Derrick Cafe both use an oil derrick symbol
in their logo, there should be no confusion of the two.

If you are designing a logo for a local business, it probably won’t matter if your design is similar to
that for another business in another geographical area. If, however, you are designing a logo for a
company with a larger area of operations, or you think you may someday trade nationally, you
should consider registering your logo.

Definitions
This chapter consists chiefly of pertinent excerpts from Basic Facts About Trademarks, a publication of
the U.S. Government Printing Office (October 1992). The definitions it uses vary somewhat from
those we gave in Chapter 1. Again, the definitions used in this book are:

Logo: The general term for the more specific terms signature, mark, or wordmark.

Signature : The name of a company or individual set in a distinctive style of type.

Mark: A graphic design used to represent a company.

Signature + Mark: Displaying a company’s signature next to its mark.

Wordmark: A graphic design that incorporates the name of the company into the design.

Where we feel clarification of the words of the U.S. Government is useful, we will preface our remarks
with the heading “Comments.”

What Is a Trademark?
A trademark is either a word, phrase, symbol or design, or combination thereof, which identifies and

distinguishes the source of the good or services of one party from those of others. A service mark is the same
as a trademark except that it identifies and distinguishes the source of a service rather than a product.
The terms “trademark” and “mark” are used to refer to both trademarks and service marks whether
they are word marks or other types of marks.

Comments
This means that to the government, a logo is the same thing as a trademark or service mark —
depending on what the company it represents does. The logo is a trademark if the company’s product
is a good; it is a service mark if the company’s product is a service.

In other words, because Quaker sells oats, its signature is a trademark; but since Arthur Andersen
& Company sells financial services, its signature is a service mark. Quaker’s mark is a trademark;
United Way’s mark is a service mark.

Whether the government considers the logo you have designed to be a trademark or service mark
depends upon what you are selling.
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How Can Someone Establish Rights?
Trademark rights arise from either (1) actual use of the mark, or (2) the filing of a proper application
to register a mark in the Patent and Trademark Office (PTO) stating that one has a bona fide intention
to use the mark in commerce regulated by the U.S. Congress.

Federal registration is not required to establish rights in a mark. However, federal registration can secure
benefits beyond the rights acquired by merely using a mark. For example, the owner of a federal
registration is presumed to be the owner of the mark for the goods and services specified in the registration,
and to be entitled to use the mark nationwide.

There are two related but distinct types of rights in a mark: the right to register and the right to use.
Generally, the first party who either uses a mark in commerce or files an application in the PTO has
the ultimate right to register that mark. The PTO’s authority is limited to determining the right to
register.

The right to use a mark can be more complicated to determine. This is particularly true when two parties
have begun use of the same or similar marks without knowledge of one another and neither has a federal
registration. Only a court can render a decision about the right to use, such as issuing an injunction or
awarding damages for infringement.

It should be noted that a federal registration can provide significant advantages to a party involved
in a court proceeding. The PTO cannot provide advice to parties concerning rights in a mark. Only
a private attorney can provide such advice.

Unlike copyrights or patents, trademark rights can last indefinitely if the owner continues to use the
mark to identify its goods and services. The term of a federal trademark is 10 years, with 10-year
renewal terms. However, between the fifth and sixth year after the date of initial registration, the
registrant must file an affidavit setting forth certain information to keep the registration alive. If no
affidavit is filed, the registration will be canceled.

Comments
It isn’t necessary to register your logo with the PTO. Just using it to represent yourself and your goods
and services establishes it as your logo. However, if someone else begins using a logo similar to yours,
and you want them to stop using it, being able to point to a federal registration of your logo is
advantageous.

Applications
An applicant may apply for federal registration in three principal ways.

1. An applicant who has already used a mark in commerce may file based on that use (a “use”
application).

2. An applicant who has not yet used the mark may apply based on a bona fide intention to use the
mark in commerce (an “intent to use” application).

For purposes of obtaining federal registration, commerce means all commerce which may lawfully be
regulated by the U.S. Congress; for example, interstate commerce or commerce between the U.S. and
another country. The use in commerce must be a bona fide use in the ordinary course of trade, and not
made merely to reserve a right in a mark. Use of a mark in promotion or advertising before the product
or service is actually provided under the mark on a normal commercial scale does not qualify as use
in commerce.
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3. Under certain international agreements, an applicant may file in the U.S. based on an application or
registration in another country.

Searches for Conflicting Marks
An applicant is not required to conduct a search for conflicting marks prior to applying with the PTO.
However, some people find it useful. In evaluating an application, an examining attorney conducts a
search and notifies the applicant if a conflicting mark is found. However, the application fee, which covers
processing and search costs, will not be refunded even if a conflict is found and the mark cannot be
registered.

To determine whether there is a conflict between two marks, the PTO determines whether there would
be likelihood of confusion; that is, whether relevant consumers would be like to associate the goods or
services of one party with those of the other party as a result of the use of the marks at issue by both
parties.

The principal factors to be considered in reaching this decision are the similarity of the marks and the
commercial relationship between the goods and services identified by the marks. To find a conflict, the marks
need not be identical, and the goods and services do not have to be the same.

The PTO does not conduct searches for the public to determine if a conflicting mark is registered, or is
the subject of a pending application, except as noted above when acting on an application. However,
there are a variety of ways to get this same type of information.

1. Performing a search in the PTO public search library, located on the second floor of the South Tower
Building, 2900 Crystal Drive, Arlington, Virginia 22202.

2. Performing a search at a patent and trademark depository library. (See end of chapter.)

3. Retaining a private trademark search company or an attorney who deals in trademark law.

Further Filing Information
Information about filing for federal trademark registration and the forms themselves can be obtained
online by visiting:

http://www.uspto.gov

All trademark-related correspondence filed by mail, except for requests to record documents in the
Assignment Services Division, requests for copies of trademark documents, and certain documents
filed under the Madrid Protocol should be addressed to:

Commissioner for Trademarks
P.O. Box 1451
Alexandria, VA 22313-1451

In addition, inquiries can be serviced by calling 1-800-786-9199 or 703-308-HELP (4357) for general
trademark and patent information which includes 24-hour technical & genneral support. Services are
available 24 hours a day, 7 days a week.
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Patent & Trademark Depository Libraries
The following is a list of libraries where you can conduct your own search for trademark conflicts (and
possibly save yourself $210).You may wish to call the above number to see if a library has opened in your
area since this list was compiled.

State Library Telephone

AL Ralph Brown Draughon Library, Auburn .. ................................ 334/844-1737
Birmingham Public Library ....................................................... 205/226-3620

AK Anchorage: Loussac Public Library.......................................... 907/562-7323
AZ Tempe: Noble Library, Arizona State University ........................ 602/965-7010
AR Little Rock: Arkansas State Library........................................... 501/682-2053
CA Los Angeles Public Library ....................................................... 213/228-7220

Sacramento: California State Library, Courts Bldg. .................. 916/654-0069
San Diego Public Library .......................................................... 619/236-5813
San Francisco Public Library ................................................... 415/557-4500
Sunnyvale Public Library .......................................................... 408/730-7300

CO Denver Public Library ............................................................... 720/865-1711
CT Hartford Public Library .............................................................. 860/695-6300
DE Newark: University of Delaware Library ................................... 302/831-2965
DC Washington: Founders Library, Howard University .................. 202/806-7252
FL Fort Lauderdale: Broward County Main Library ........................ 954/357-7444

Miami-Dade Public Library ....................................................... 305/375-2665
Orlando: University of Central Florida Libraries ........................ 407/823-2562
Tampa: Tampa Campus Library, Univ. of South Florida ........... 813/974-2726

GA Atlanta:Georgia Institute of Technology .................................... 404/894-1395
HI Honolulu: Hawaii State Public Library ....................................... 808/586-3477
ID Moscow: University of Idaho Library ......................................... 208/885-6584
IL Chicago Public Library ............................................................. 312/747-4450

Springfield: Illinois State Library ................................................ 217/782-5659
IN Indianapolis-Marion County Public Library ............................... 317/269-1741

West Lafayette: Siegesmund Engineering Library, Purdue...... 765/494-2872
IA Des Moines: State Library of Iowa ............................................ 515/242-6541
KS Wichita: Ablah Library, Wichita State University ....................... 800/572-8368
KY Louisville Free Public Library .................................................... 502/561-8617
LA Baton Rouge: Troy H. Middleton Library, LSU .......................... 225/578-8875
ME Orono: Raymond H. Fogler Library, University of Maine........... 207/581-1678
MD College Park: Eng. & Phys. Science Library, Univ. of MD ........ 301/405-9157
MA Amherst: W.E.B Du Bois Library, Univ. of Mass. ...................... 413/545-2765

Boston Public Library ............................................................... 617/536-5400, ext. 2226
MI Ann Arbor: Media Union Library, University of Michigan ............ 734/647-5735

Big Rapids: (FLITE), Ferris State University ............................ 231/591-3602
Great Lakes Patent and Trademark: Detroit Public Library ...... 313/833-3379

MN Minneapolis Public Library ........................................................ 612/630-6000
MS Jackson: Mississippi Library Commission ............................... 601/961-4111
MO Kansas City: Linda Hall Library ................................................ 816/363-4600, ext. 724

St. Louis Public Library ............................................................. 314/241-2288, ext. 390
MT Butte: Montana Tech. Library: University of Montana ................ 406/496-4281
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NE Lincoln: Eng. Library, Univ. of Nebraska-Lincoln ...................... 402/472-3411
NV Las Vegas: Clark County Library District ................................. 702/507-3421

Reno: University of Nevada-Reno Library ................................ 775/784-6500, ext.257
NH Durham: Univ. of New Hampshire Library ................................ 603/862-1777
NJ Newark Public Library .............................................................. 973/733-7779

Piscataway: Library of Science & Medicine, Rutgers .............. 732/445-2895
NM Albuquerque: Centennial Science and Engineering, U of NM... 505/277-4412
NY Albany: New York State Library, Cultural Education Center ..... 518/474-5355

Buffalo and Erie County Public Library..................................... 716/858-8900
Science, Industry and Business Library, NY Public Library ..... 212/592-7000
Rochester: Central Library of Rochester and Monroe Cty. ...... 585/428-8110
Melville Library, Room 1101, SUNY at Stony Brook .................. 631/632-7148

NC Charlotte: University of North Carolina ..................................... 704/687-2241
Raleigh: D. H. Hill Library, North Carolina State University ....... 919/515-2935

ND Grand Forks: Chester Fritz Library, Univ. of North Dakota ....... 701/777-4888
OH Akron: Akron-Summit County Public Library ............................ 330/643-9075

Cincinnati and Hamilton County Public Library ........................ 513/369-6971
Cleveland Public Library ........................................................... 216/623-2870
Columbus: Ohio State University ............................................. 614/292-3022
Dayton: Wright State University ................................................ 937/775-3521
Toledo/Lucas County Public Library ......................................... 419/259-5209

OK Stillwater: Edmon Low Library, Oklahoma State University ...... 405/744-7086
OR Paul L. Boley Law Library, Lewis & Clark College .................... 503/768-6786
PA Philadelphia, The Free Library of .............................................. 215/686-5331

Pittsburgh, Carnegie Library of ................................................. 412/622-3138
University Park: Paterno Library, Penn State Univ. ................... 814/865-6369

RI Providence Public Library......................................................... 401/455-8027
SC Clemson: R.M. Cooper Library, Clemson University ................ 864/656-3024
SD Devereaux Library, South Dakota School of Mines and Tech. . 605/394-1275
TN Stevenson Science & Engineering Library, Vanderbilt Univ. ..... 615/322-2717
TX Austin: McKinney Engineering Library, ECJ 1.300, UT ............. 512/495-4500

College Station: TIP2, Texas A& M University ........................... 979/458-1819
Dallas Public Library ................................................................ 214/670-1468
Houston: Fondren Library,- MS 225,  Rice University ............... 713/348-5483
Lubbock: Texas Tech University Library ................................... 806/742-2282
San Antonio Public Library........................................................ 210/207-2500

UT Salt Lake City: Marriott Library, University of Utah .................... 801/581-8394
VT Burlington: Baily/Howe Library University of Vermont ............... 802/656-2542
VA Richmond: Cabell Library, Virginia Commonwealth Univ. ........ 804/828-1104
WA Seattle: Engineering Library, Univ. of Washington .................... 206/543-0704
WV Morgantown: Evansdale Library, West Virginia Univ. ............... 304/293-4695, Ext. 5113
WI Madison: Wendt Library, Univ. of Wisconson-Madison ............ 608/262-6845

Milwaukee Public Library .......................................................... 414/286-3051
WY Cheyenne: Wyoming State Library ........................................... 307/777-7281

State Library Telephone



Appendix A: Design Elements





Appendix B: Designs





Appendix C: Icons





Appendix D: Design Examples




	Logo Design Guide
	Preface
	Table of Contents
	Chapter 1: Design Considerations
	Signature
	Mark
	Wordmark
	Checklist for a Good Mark

	Chapter 2: Creating a Logo
	Creating a Logo Using Clip Art
	Using the Designs, Patterns, and Icons

	Chapter 3: Designing a Letterhead
	Paper
	Message Area
	Type in the Letterhead
	Envelopes

	Chapter 4: Designing a Business Card
	Calling Cards
	Business Cards
	Media & Message
	Checklist for a Good Business Card

	Chapter 5: Designing a Product Label
	Allied Beverage's Ice Mountain Soft Drinks
	Designing a Wordmark
	Creating a Product Lable

	Chapter 6: Protecting Your Logo
	Definitions
	What is a Trademark?
	How Can Someone Establish Rights?
	Applications
	Searches for Conflicting Marks
	Further Filing Information
	Patent & Trademark Depository Libraries

	Appendix A: Design Elements
	Appendix B: Designs
	Appendix C: Icons
	Appendix D: Design Examples
	Print The Design Guide
	Visit www.arts-letters.com

